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System Requirements 
Below are the minimum system specifications for a computer to run PVP: 

• Processor: 64-Bit Intel Core 2 Duo processor or better 
• OS 

• macOS 10.12.6 (Sierra) 
• macOS 10.13.6 (High Sierra) 
• macOS 10.14.4 and above (Mojave)* 

• RAM: 4GB 
• Hard Drive: 300MB (100 MB for application; 200MB for sample show) 
• Internet connection (for registration and Sample Show download) 

Note that these are the minimum requirements. 
For optimal performance, especially for higher end uses (such as multiple outputs, 
multiple layers, HD content, etc.), you will want to consider a stronger computer. 

*For Mojave (macOS 10.14) users, we recommend that you run PVP3 on 10.14.4 or 
above for optimal performance due to deprecation in the OpenGL technology on 
the Mojave macOS.  Common issues on macOS Mojave are dropped-frames and 

sub-optimal playback in some cases 

All Macs sold today will meet these specs, however, your best results will be with an 
iMac or MacBook Pro with a dedicated graphics card (AMD or NVIDIA), or a Desktop 
“Pro” computer (iMac Pro, or Mac Pro), especially for higher-end uses (such as 
multiple outputs,  multiple layers, HD content, etc.). 

Additional consideration should be given to any hardware limitations of a given 
device (such as the number and type of ports available the computer).  For 
example, some MacBooks and MacBook Airs meet the specs to run PVP, however, 
they have limited ports available and as such we don’t recommend those as 
production computers.  
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Additional hardware such as video cables and adapters may also be needed based 
on your computer’s connections and the input options of your devices. 

If you have questions about a specific setup and what computer we would suggest, 
please contact our Support team.   

Page   of  6 92

http://contact.renewedvision.com


Setting up your Mac 
The first step in setting up PVP is getting the machine ready for the program by 
turning off a feature of the operating system that can conflict with Renewed Vision’s 
products. 

1. Click on the Apple icon   in the upper left corner of your screen and select 
System Preferences 

2. Click on Mission Control (middle of the top row) 
3. Uncheck Displays have Separate Spaces 
4. Restart the computer 

Additionally, we recommend setting the desktop background for all external 
monitors to a solid color (such as black) as well as disabling the screensaver and 
adjusting the energy settings as needed. 

Some LED screens can make it difficult to set the desktop background due to the 
way that the system preferences show on each output and how LED screens don’t 

always show the entire output; in these cases it might be helpful to try a screen 
sharing software to see your output’s screen and change the desktop background. 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Setting up your Outputs 
PVP can output to a multitude of software and hardware components. This section 
will provide a quick overview of the output types as well as how to get them ready 
to be seen by PVP. For more information on how to connect PVP to these devices, 
please see the Screens section. 

Note that we recommend that you set up your Show while all hardware/software 
components are plugged in and turned on, however this is not required; 

it is possible to set up your Show using placeholders (called Custom Screens) 
and link them up to the actual components at a later time. 

 

System (External Monitors) 

PVP can output to any external monitor that your operating system 
can see. Examples of this are VGA, DVI, and HDMI outputs (often 
requiring Thunderbolt or USB adapters), but there are other possible configurations 
that might fall under this heading. In general: If the operating system sees it as an 
external monitor (that is you can drag a window from your primary monitor to a 
given component), then it will fit into the “System” description. 

Setup for these outputs would be plugging the device into your computer (using 
any necessary adapters) and making sure that the operating system can see it as an 
external monitor. If the operating system can’t see it, PVP won’t be able to see it. 

Note that USB adapters often require drivers to be installed before they will work;  
check with your device manufacturer for more information. 

SDI and HD-SDI 

SDI (short for Serial Digital Interface) and HD-SDI 
are broadcast standards for sending digital video signals long distances. SDI and 
HD-SDI requires additional hardware to bring the signal out of your computer 
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(typically the Blackmagic UltraStudio Mini Monitor) as well as hardware on the 
receiving end that can interpret the signal. 

Note that PVP makes no distinction between SDI and HD-SDI; 
therefore in this user manual we will use the term “SDI” to refer to both. 

You can also send an Alpha Key output over SDI provided you have a supported 
BlackMagic hardware device.   

Setup of an SDI output requires hardware to convert the signal to SDI (see a full list 
of supported hardware here) as well as the drivers associated with your device 
(click here for Blackmagic’s support page).   

 

NDI 

NDI (short for Network Device Interface) is a protocol created 
by NewTek that allows media to be sent over the network to 
other software or hardware devices. NDI is a new technology and adoption is 
continuing to grow, so continue to check for new hardware and software that 
supports this exciting new technology. 

Setup for NDI is as simple as making sure that the computer running PVP is on the 
same network as the software/hardware receiving the signal. 

You can send an Alpha Key output over NDI by enabling this in the Screens area of 
the Workspace Editor.   
 

Syphon 

Syphon is an open source technology that allows programs to share 
media (videos and still images) with other software on the same computer. 
Common uses for Syphon would be to bring the output from PVP to a separate 
piece of software that would map it for environmental projection before being sent 
to the hardware. 
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Setup for Syphon would be to run the corresponding software before opening PVP 
so that PVP can acknowledge the other software’s presence. 
 
Syphon natively sends an Alpha Key output out of the program, so provided you are 
using content with transparency in it, that transparency would appear on the signal 
in the receiving software.   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Installing PVP 
PVP is only available for download from our website. Go to the link below to 
download the latest version of PVP. 

renewedvision.com/provideoplayer/download 

Even if you purchase PVP through an authorized reseller you should still download 
it from our website to ensure you have the latest version of the program. 

The current version is available at the top of the page; recent updates are available 
at the bottom of the page if you need an older version. 

  

When PVP downloads it will download as a .zip file. If your browser doesn’t 
automatically unzip the file, then after the file downloads you may need to double 
click on the .zip file to unzip it. Once you have the PVP application unzipped, simply 
drag it to your Application folder. 

You can now open the application from the Applications folder. Many users also 
find it useful to add the application to the Dock by either dragging the application 
from the Application folder onto the Dock or, if the application is already running, 
by right-clicking on the application’s icon in the Dock and selecting Options > Keep 
in Dock.  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Setting Up PVP 
Welcome Window 

When you open PVP you will be welcomed by the Welcome Window, seen below. 

  

This window lets you get up and running quickly inside of PVP. The buttons in the 
center allow you to Create a New Show, Open a Sample Show, and open this 
User Manual. On the right there is a list of recently opened Shows; click on one to 
open it. Click on Open another Show… at the bottom to open a Show that is not 
listed in the list. 

This Welcome Window can be opened at a later time by clicking on the Window 
menu in the menubar and selecting Welcome to PVP. 

If you want this window to show every time you open PVP, head to the System 
Preferences and, in the General tab, check the box next to Close windows when 

closing an app. If you want PVP to open to the Show that was open when you last 
quit PVP, uncheck the box next to Close windows when closing an app.  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New Show Wizard 

When you create a new Show, you will see the New Show Wizard which will help 
you to quickly set up Screens and Targets in your Show. 

  

PVP will automatically add Screens for each external monitor that you have 
currently attached to your computer. If you would like to add additional Screens, 
click the + in the lower left of the window. To delete one of the Screens, select it and 
press the delete key, or, if you have a touch pad, swipe with two finders to the left 
over the name of the Screen and then click Delete. 

For each Screen in the window, you can update the Name as needed by clicking on 
the name and typing in a new name. You can also adjust which device the Screen is 
Linked to by clicking on the drop-down menu on the right of the Screen. 

You can also have PVP automatically Create Target Sets and Create Layers for 
each Screen that you create; check the box next to each of these respective 
features to have PVP create that content in your Show. 

When you are done you can click OK to create your Show, or select Empty Show to 
close out of the Wizard without adding the content. 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Registering PVP 

PVP has a fully featured Demo Mode which runs any time you open a copy of PVP 
that is not registered. The Demo Mode is fully featured (you can use every feature 
of the product), however there will be a watermark on all of your output screens. 
This allows you to get to know the program before you purchase it. 

  

There are two ways to purchase PVP: first by purchasing it within the app, and 
second by purchasing it on our website. 

In-App Purchase 

To purchase PVP from within the app click on the green bar in the top left of the 
main window that says Register PVP… From this window you can click on the 
Purchase button to purchase PVP from the in-app store. 

Once you complete the purchase PVP will automatically register itself; it will also 
email you your Registration Name and Unlock Code. Be sure to keep this information 
safe and secure in case you need to register the software again in the future. 

Website Purchase 

To purchase PVP from our online store, head to our website: 

renewedvision.com/store.php?item=pvp 

Add PVP to your cart and check out like usual. Once you finish the checkout process 
your Registration Name and Unlock Code will be shown on the screen as well as 
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emailed to you. Be sure to keep this information safe and secure in case you need 
to register the software again in the future. 

You can then open PVP and click on the green box in the top left that says Register 
PVP… Inside of this window, click Register and enter your Registration Name and 
Unlock Code. You can enter a unique Device Name to help identify which 
computer your registration is attached to, and you must select a Volume where the 
registration will be stored. If you would like the registration to be attached to your 
computer then select the computer’s name; if you would like to register a USB 
dongle then select that specific device (see below). Once all of your information is 
correct, click on Register to finish the registration. 

Dongle Registration 

Most users will want to attach their registration information to the computer so 
that the computer itself is always registered and ready to use PVP, however some 
users prefer to have a more “mobile” registration code. With this in mind, PVP 
allows you to register a “dongle” (such as a USB thumb drive) with your registration 
information. Examples for using this feature would be to more easily move your 
registration information between computers, or if you regularly reformat your hard 
drives. 

To register a USB dongle, proceed through the normal registration process (as seen 
above). When it asks which Volume you would like to register, select an attached 
USB dongle. This will attach the registration to the USB device. 

If you have previously registered PVP to your computer 
and want to change the registration to a USB dongle, 

you will first need to unregister PVP and then register it again. 

Unregistering PVP 

If you need to unregister your copy of PVP (such as to move the registration to a 
new computer or to a dongle), click on PVP in the menubar in the top left, come 
down to Registration, then click on Unregister. You can now use the same 
registration information to register another computer or a dongle. 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Getting Started 

At this point PVP is up and running and ready to go. If you are new to PVP then the 
next step will be to familiarize yourself with the terminology and layout of PVP; see 
the PVP 3 Overview section for this. After that, for many users their first goal will be 
to set up their Screens/Outputs; see the section on the new Workspace Editor for 
full details on those features. Next set up your Layers to control how the media will 
play, and customize your Playlists and Cues for your setup. There are many 
additional features that you may want to check out, and of course there are many 
preferences that you can customize for your unique setup. 

In addition to this User Guide we have a set of Tutorial Videos that you may find 
useful in your PVP 3 journey. Visit the link below to view these tutorials: 

https://renewedvision.com/provideoplayer/tutorials/ 

Thank you for installing PVP, we hope you have an outstanding experience while 
using our products! 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PVP 3 Overview 
PVP (an acronym for “ProVideoPlayer”) is a video processor, a video playback 
solution, and a custom output generator, all rolled into one!  

PVP 3 is a complete reimagining of what this software has to offer. We have added 
many outstanding features that are going to help users create custom outputs 
faster and better looking than ever before! 

But these changes mean that users of previous versions of PVP will need to not only 
learn a new interface but also learn new and reimagined terminology. For example, 
the Macros feature has been completely reimagined as a Cue-based system. 
Similarly, the Target Set feature has been rebuilt from scratch for better control 
over your Targets and how they interact with your Layers. 

The section below covers the terminology used in PVP 3 as well as the overall layout 
of the program. Due to the many changes that were made we recommend that all 
users of PVP 3 read this section to better understand the terminology used in the 
application and this user manual. 

Terminology 

Workspace 
The Workspace is a coordinate system where you will set up digital versions of 
your outputs and then define where your media will play on those outputs. You will 
also use the Workspace to set up any Masks that you may want to create. 

Note that the Workspace (sometimes called the “Canvas”) uses a measurement of 
units that the user can define. Many times you will want the units to relate to pixels 

(this is the setting by default), but other times you may want them to represent 
centimeters, or a fraction of an inch, or something else entirely. This feature is 

covered in the Unit Scaling section. 
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Screen 
A Screen is the digital representation of your physical devices inside of the 
Workspace. The primary property for each screen is its Size (Height and Width) and 
its Position on the Canvas (X and Y). 

For example: You are setting up PVP to control two TVs, so you add two Screens to 
your Workspace, one for each physical device you will be sending a signal to. 

For more information: See the Screens section. 

Output 
The Output is the property of a Screen which controls how the media is sent to the 
physical device. Its primary attribute is its Size (resolution) which will generally be 
the full resolution of the physical device, however it doesn’t have to be. 

For example: You are setting up two TVs, one will be using 1920x1080 and the other 
1280x720. You would set up one Screen to use an Output size of 1920x1080 and 
another Screen to use an Output size of 1280x720. 

For more information: See the Output section. 

Output Target 
The Output Target is an optional setting where you can control where the Output 
will appear inside of (that is as a subset of) the Screen. The primary properties of an 
Output Target are its Size (resolution) and its Position on the Canvas (X and Y). 

For example: LED walls often use only a small portion of your actual output, such as 
an LED wall that is 300 pixels by 300 pixels but whose processor wants a 1920x1080 
signal from the computer. In this case you would set up your Screen to be 
whichever relative size you need it to be to match the other Screens (or use 
300x300 if relative size is not a factor), the Output would be 1920x1080 (because 
that is what the computer is outputting to the LED processor), and the Output 
Target would be 300x300 because that is the actual resolution of the physical wall. 

For more information: See the Output Target section. 
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Target 
A Target is an area of the Canvas where PVP will play content. It is defined by an 
overall shape (most often a rectangle, but it can be an oval or a custom shape) and 
its primary attributes are its Position and Size. 

You can create a Target at any location, however only parts of a Target 
that overlap a Screen will render on your physical devices. 

For example: You want a piece of media to play only in the top left of one of your 
devices, so you create a Target that covers the top left of that Output. 

For more information: See the Targets section. 

Target Set 
A group of Targets that will all play the same media is called a Target Set. 

There is no limit to the number of Targets within a Target Set. 

For example: You want the same media to play on two different Screens at the 
same time, so you create one Target Set that contains two Targets (one on each 
Screen). You want different media to play on a third Screen, therefore you create a 
second Target Set which contains one Target on the third Screen. 

For more information: See the Target Set section. 

Layer 
Layers are capsules for controlling how and where media will play. To each Layer 
you will assign a Target Set (which is where the media will play) as well as effects 
and other attributes that might change how the media looks or plays. 

For example: You create a Layer called Tiled; to this Layer you link the Target Set 
which has Targets tiled across your Screen. You also add an Effect to the Layer so 
that the media played back will have an Effect applied to it. 

For more information: See the Layers section. 
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Action 
An Action is a single command that happens inside of PVP. This is most commonly 
sending media to a specific Layer, however it might be one of many commands 
such as Clearing a Layer or assigning an Effect to a Layer. 

For example: You want to show a single piece of media inside of a Layer; to perform 
that command would be called an Action. 

For more information: See the Actions section. 

Cue 
A group of Actions is called a Cue. To put it another way, a Cue is a way to trigger 
one more more Actions (visible or non-visible) with one click. You can have as many 
Actions inside of one Cue as you would like, and you can individually edit each 
Action that is inside of a Cue. 

The Cue feature is the next iteration of what is called Macros in PVP 2. 

For example: You want to show three pieces of media in three different Layers all in 
one click, so you create a Cue that has three Actions, one for each piece of media 
that will play in a Layer. 

For more information: See the Cues section. 

Show 
A Show is a single file on the computer that contains all needed information for an 
event. The Show file includes all of your Screens, Outputs, Targets, Layers, Cues, 
Media, and anything else inside of PVP that you might want to save pertaining to 
one show/event. You can create as many Shows as you would like and save them 
on your computer, however you can only have one Show open at any given time. 

For more information: See the Shows section.  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Interface Overview 

  

For more information on a given topic, click on the underlined phrase. 

The primary interface is broken up into several sections. The Playlist Bar is on the 
left side; this is where you will create Playlists full of Cues and Actions. The Layer 
Bar is across the top and will show your Layers (and, optionally, details about your 
layers). The right side features the Sidebar which gives you easy access to 
whichever Layer is selected at the moment. (You can toggle the Sidebar on and off 
by clicking on the Sidebar button   on the top right of the screen.) 

The center area of the program is the Cue/Action area; for most users this will be 
the area that you interact with the most during a show. The default mode is the 
Cue View which shows you all of the cues in a selected Playlist, but you can change 
this area to the Action View which allows you to fire Actions directly as well as have 
a visual way to set up your Cues. 

Click the Workspace Editor button   in the top right to toggle the Workspace 
Editor; this is where you will edit items in the Workspace, such as your Screens, 
Targets, and Masks. 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Workspace Editor 
The Workspace Editor is often the first place that users interact with PVP because it 
is the first stop in setting up your Screens, Outputs, and Targets. This section covers 
the visual aspects of the Workspace Editor, such as how to set the zoom level and 
how to turn on and adjust the grid. 

  

To open the Workspace Editor click on the Workspace Editor button   in the top 
right of the screen. To close the Workspace Editor, click on the same button again. 

On the right are the three tabs where you will set up the different features in the 
Workspace Editor: Screens, Targets, and Masks; these tabs will be covered in their 
respective sections. 

Note that the Sidebar will continue to show even if you are in the Workspace Editor. 
This can be helpful if you want a live preview of what your Master or a specific Layer 

will look like while you are editing objects in the Workspace Editor. 
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Canvas 

The central area of the Workspace Editor is the canvas where you will see 
representations of the objects that you are setting up. The canvas uses an (X, Y) 
coordinate system which uses units that the user can define (see Unit Scaling). 
Many users will define one Point as one Pixel, however depending on your setup 
you might choose to define one Point as one-tenth of an inch, or one centimeter, or 
something else entirely. 

Note that the coordinate system has changed slightly from previous versions. 
In PVP 3, (0,0) will be in the top left of the screen and (∞,∞) is in the lower right. 

(-∞,-∞) will take you up and to the left. 
 

In the lower left of the Workspace Editor you will see the current position of your 
cursor as well as the Width and Height of the currently selected object. 

Moving within the Canvas 

You can move around the Canvas using traditional methods (by using the scroll 
bars, for example), however there are additional shortcuts that can be used to 
make this faster. 

If you have a mouse with a scroll wheel you can scroll vertically in the Canvas by 
using your scroll wheel, or hold Shift and scroll the wheel to scroll horizontally. If 
you are using a trackpad (including devices like the Magic Mouse) then use two 
fingers to scroll horizontally or vertically. You can also hold down the Command key 
and click and drag on the main Canvas window to drag the view. 

(-∞,-∞) -∞ (∞,-∞)

-∞ (0,0) ∞

(-∞,∞) ∞ (∞,∞)
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To zoom in or out in the Canvas you can hold the hold the Option key down while 
you scroll, or use Pinch to Zoom if you have a trackpad. You can also use keyboard 
shortcuts to zoom; press Command-Plus to Zoom In, Command-Minus to Zoom 
Out, and Command-0 to Zoom to Fit. See the Zoom feature for additional control. 

Adjusting the Canvas 

The Canvas contains several tools to customize how it looks and feels. These 
buttons are in the lower right of the Workspace Editor and are available any time 
the Workspace Editor is open. 

Unit Scaling 

The Unit Scaling option allows you to specify a conversion rate for the Workspace 
Editor. This is useful if you will be using a custom scaling option when you set up 
your Screens, Targets, and Masks. 

  

For example, if you are setting up two TVs and one is a 42” TV and the other is a 55” 
TV, then it would be helpful to set the Unit Scaling inside of the Workspace Editor 
to, say, 1 Inch per 10 Pixels. This would mean that each Pixel (“px”) is equal to one-
tenth of an inch. You can then use a tape measure to measure your screens to 
create an accurate representation of your physical devices. 

Note that the sole purpose of Unit Scaling is to assist you in setting up your Canvas. 
This setting has no impact on the actual output of PVP. 

To set up a custom Unit Scale, click on “1pt = 1px” in the lower right of the 
Workspace Editor. Click on the up/down arrows in the middle to change the Unit. 
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Available Units are: 
• Points (“pt”, an arbitrary point value) 
• Inches (“in”) 
• Feet (“ft”) 
• Millimeters (“mm”) 
• Centimeters (“cm”) 
• Meters (“m”) 

Change the number on the left and/or the right to adjust the ratio between the Unit 
and the pixels inside of the Workspace Editor. Click on Reset to Default to reset 
the feature to the default settings (1pt = 1px). Click outside of the Unit Scaling 
window to close the window. 

Background Image 

The Background Image feature (accessible by clicking the Background Image 
button   in the lower right of the Workspace Editor) allows you to add an image as 
the background of the Workspace Editor. This can be helpful to line up Screens and 
Targets if you already have a diagram or a photo of your physical devices. 

  

We recommend a .jpg or .png file for use as your Background Image, 
however this feature will support a wide range of still image file formats. 
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Click on Choose… to select an image file to use as your Background Image. You can 
toggle the feature on and off by clicking on the box next to Enable or by holding the 
Option key while clicking on the Background Image button  . (This will allow you to 
hide the Background Image without it losing the settings.) 

The Position and Size options will allow you to enter a specific coordinate and size 
for the image; you can also click and drag the bounding boxes around the 
background image itself. (These bounding boxes are only visible while the 
Background Image window is open.) 

The Opacity slider allows you to adjust the transparency of the Background Image 
if needed. Click on Remove Background Image to remove the Background Image 
altogether. Click outside of the Background Image window to close the window. 

Guides 

PVP allows items inside of the Workspace Editor to “snap” to Guides; you can adjust 
these Guides by clicking on the Guides button   on the lower right of the 
Workspace Editor. 

  

Workspace Guidelines are guides that you can add yourself to your Workspace 
Canvas so that you can “snap” your objects to a predefined coordinate. 

Note: To create Workspace Guidelines you must have the Rulers feature enabled. 
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Once you click the checkbox next to Show Guidelines you can then create as many 
Guidelines as you would like. For a vertical Guideline, hover your mouse over the 
Ruler on the left side of the Canvas then click and drag onto the Canvas. Release 
the mouse where you want your Guideline to be placed. Horizontal Guidelines can 
be created by clicking and dragging from the Ruler on the top of the Canvas. To 
remove a Guideline, click and drag it up (for horizontal Guidelines) or to the left (for 
vertical Guidelines) and release the mouse when the   icon appears. 

Alignment Guides will have objects snap to other objects that are in the Canvas. 
For example, if you are dragging some Screens around and you want them to all 
snap to the same distance apart, turn on Show Relative Spacing, set up two 
Screens at the desired distance, and then future screens will snap to their relative 
spacing. Show Relative Sizing works similarly in that it will have objects snap to the 
same size as other objects. If you want for your objects to snap to the centers and/
or edges of other objects then you can turn on Show Object Center Guides and/or 
Show Object Edge Guides. 

Each of these sections can have their own colors. Click on the color swatch to select 
a color (and optionally transparency) of that item. Hold Option when you click on 
the Guides button   to quickly enable/disable this feature. Click outside of the 
Guide window to close the window. 

Grid 

To add a grid of lines to the Workspace Editor to help align your objects click on the 
Grid button   in the lower right of the screen. 
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To toggle this feature, toggle the checkbox next to Enable, Option-click on the Grid 
button   , or press Command-Option-Apostrophe. Click on the Color option to 
select which color you would like to use for your Grid. 

You can adjust the spacing of the Grid by setting the Spacing (the space between 
the major lines) and Subdivisions (minor lines that appear between the major 
lines). Click outside of the Grid window to close the window. 

Rulers 

The Workspace includes a set of Rulers that will show on the top and left edges of 
the screen to better help you see the positioning of the objects in the Workspace. 

  

You can enable and disable the Rulers by clicking on the Rulers button   in the 
lower right of the Workspace Editor or by pressing Command-R. 

Zoom 

To adjust the zoom level of the Workspace Editor select the Zoom button   in the 
lower right. 

  

You can select a predefined value or you can select Custom… to enter your own 
value. To have PVP zoom so that you can see everything on your screen, select Fit, 
Option-click on the Zoom button   , or press Command-0. Click outside of the 
Zoom window to close it. 
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Interacting with Objects 

There are several ways you can interact with objects (such as Screens, Targets, and 
Masks) in the Workspace Editor. Here are a few quick tips to get more out of PVP: 

• Click and drag an object to position it where you want it to be 
• Hold down the Shift key while dragging a bounding box to lock the aspect ratio 
• Hold down the Command key while dragging a bounding box to scale from the 

center of the object instead of the far corner of the object 
• Hold the Option key when you click and drag an object to copy (duplicate) that 

object 
• Hold the Command key and hover your mouse near a bounding box to turn the 

cursor into a Rotate curser 

To Align multiple objects, select multiple items, then, from the menubar, select 
Editor and click Align; from here you can align your items horizontally or vertically. 
Similarly you can select multiple items and select Distribute from the Editor menu 
to distribute your items horizontally, vertically, or evenly.  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Screens 
The Screens tab inside of the Workspace Editor allows you to set up digital 
representations of your physical devices inside of PVP. Remember to read the 
Terminology section for an overview of the new terminology in PVP 3. 

One additional term that will be used in this User Guide is the idea of Linking 
Screens. To Link a screen is to assign a Screen inside of PVP to either a device or, in 
some cases, a piece of software. It is this Link that allows PVP to know where to 
send the content. 

Note that Screens don’t have to be Linked. 
You can create a Custom Screen that is not linked to a specific device 

or, in rare cases, you might have an Unconfigured Screen. 

Screen Types 

There are multiple types of Screens that PVP can output to. There is a list explaining 
the different connections in the Setting up your Outputs section, but there are two 
more types that need to be covered: 

Custom Screens allow you to create a Screen that is not Linked to any particular 
type or device (that is, they are Unlinked at creation). Think of it as a blank slate that 
you will fill in (Link) later. 

Custom Screens are great for creating a Show when you don’t have direct access 
to the hardware; simply create the Custom Screens now and Link them later! 

Unconfigured Screens can happen if you have a device is unplugged or is 
otherwise unable to be linked properly. You can relink it by clicking on the Screen 
and selecting a new Output from the Output menu. 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Create New Screen 

To create a new Screen click the Create New Screen 
button on the top of the Screens tab. It will prompt you 
to select which type of Screen you would like to create. 

Configured Screens 

The Configured Screens section will show a list of all of 
the Screens that are currently set up in your Show. Click 
on one of the Screens in the list to select it; click and 
drag on the name of a Screen to rearrange the order of 
Screens; click on a Screen and press the Delete key to 
delete a Screen. 

This window will also show you the Linked status of 
your Screens. To the right of the screen name are some 
brackets; Green brackets   indicate a Linked Screen, 
Orange brackets   indicate a Custom or 
Disconnected Screen. 

Identifying Outputs and Screens 

Sometimes, during setup, it can be helpful to be reminded which Screens and 
Outputs have been set up and how they have been Linked. To help with this there 
are options to help identify your Screens and Outputs. 

Note that PVP’s output must be turned on (Command-1) 
before these features can be used. 

Clicking on Start Identifying Screens will toggle PVP’s output to show you 
information for each of your linked Screens/Outputs. This is helpful if you are trying 
to set up multiple devices and you need to see which one is linked inside of PVP. 

The Start Identifying Outputs button is similar, however instead of showing the 
entire resolution of the Output, it will show you the resolution of your Output 
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Target. This is helpful if you have used the Divide Screen option to create multiple 
Screens from one output, or if you have otherwise used the Output Target feature 
to show only a subset of the Output on your physical device (such as if you are 
using an LED wall). 

Properties 

In the Properties section you will adjust the properties 
of a selected Screen. Adjust the name and color of the 
Screen at the top of the section, and below that you can 
see/adjust the Screen’s Position and Size. 

Note that the color of the Screen is only for 
organizational purposes; it doesn’t affect the output. 

You can adjust the Aspect Ratio of the screen as well as control if the Aspect Ratio 
is Locked (changing either the Height or Width will also change the other one to 
keep the same Aspect Ratio) or Unlocked (changing one will not change the other). 
You can also adjust the Screen’s Rotation by clicking and dragging on the wheel or 
manually entering a number. 

Sometimes you want to create one Output, but you want to divide it up between 
multiple physical devices. One common example for this is the use of a Matrox 
TripleHead2Go which tricks the computer into seeing one external monitor then 
dividing that output to go out to three different devices. One quick way to set this 
up inside of PVP is to click on Divide Screen…; doing so will allow you to specify 
how many Rows and Columns you want the divided Screen to be. Once you click 
Divide it will cut the one screen up into smaller chunks that you can then move 
around the Workspace Editor as needed. 

Output 

The Output option allows you to link a physical device 
to the Screen (which is the digital representation of that 
device). 
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Click the drop-down menu to select which device you would like to link to your 
Screen. The parameters of the Output are editable after you have selected the 
correct link. 

Alpha Key 

If you are using an SDI, NDI, or Syphon output, you can send an output with an 
alpha value for the purpose of keying outside of the software, which we call Alpha 
Key.  For specifically SDI or NDI, a check box for Alpha Key will appear allowing you 
to enable this key output while Syphon will do this automatically.  Enabling Alpha 
Key will allow PVP to provide perfectly keyed alpha-channel support for text, 
graphics and video.   

For SDI, you will need a supported Blackmagic device that supports alpha key.  A list 
of supported devices can be found here.   
You will be given the option for an Internal Key or External Key.   

Internal Key:  This is a downstream key.  
For example, if you are using PVP with a 
video input coming into the BlackMagic 
device, the BlackMagic device would act as 
the keying device placing the alpha key 
output from PVP over the video input 
signal.  The output of the BlackMagic device 
would be the composite output of the two 
inputs (Alpha Key from PVP and the video 
input). 
External Key:  This is a linear key.  This 
would send a separate key and fill output 
to your broadcast switcher.  It sends the 
key and fill signals through two different 
output spigots on the BlackMagic device.   

For NDI, simply checking the box will send an RGB-A signal out over the network.  
This is adding an Alpha channel to the output and then allows for overlay through 
your switcher or another source receiving the NDI signal.   
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Syphon will work this way automatically if the content being sent has an alpha 
channel in it already.   

Output Target 

Some devices require that only a subset of the device has the output turned on. For 
example, many LED walls will require a 1920x1080 signal from the computer even 
though the wall itself has far fewer pixels. 

The Output Target feature allows you to select a subset of the Output that PVP will 
use. Click the disclosure triangle   next to Output Target to expand this area of the 
window. Set the Position and Size properties to the 
necessary resolution and position for your device. Click 
the checkbox next to Locked to lock the Aspect Ratio. 

Click Visual Editor to see a visual representation of the 
full output on the Canvas. You can click and drag this 
new box to adjust the Output Target visually. Click on 
Reset to reset the Output Target settings. 

Corner Pinning 

If you need to fix a keystone issue (such as if your 
projector is not perpendicular to your screen) then you 
can use the Corner Pinning feature inside of PVP. 

Check the checkbox next to Corner Pinning to enable this feature. You will see eight 
number boxes, two for each corner of the Screen. Manually enter a number or use 
the arrow buttons to adjust each value as needed; you will see a representation of 
the fix in the Canvas. 

Note that the Corner Pinning feature uses Delta ∆ values; that is they represent the 
difference values from the coordinates of the original point. These values can be 

positive or negative and are limited to 25% of the resolution of the Screen. 
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Edge Blending 

PVP’s Edge Blending feature allows you to set up and adjust edge blended 
projectors. 

Note that you can add as many screens to an Edge Blend as you want. You can 
create horizontal Edge Blends and vertical Edge Blends, however you cannot have a 

group of screens that are in both a horizontal and vertical blend configuration. 

To create an Edge Blended Screen, first create at least one Screen in the Workspace 
Editor. Then either right-click on the Screen and select one of the Edge Blend 
options or hover your mouse over the edge that you desire to use for the Edge 
Blend and click when you see the Add Edge Blend icon  . Select an existing Screen 
or create a new Screen to generate an Edge Blend. 

If using the hover method, the edge that you hover the mouse over will be the side 
that the Edge Blend will be added to. Thus, if you want the current screen to be the 
left side of the Edge Blend, hover your mouse over the right edge as that is where 

the next Screen will be added. 

Once an Edge Blend has been created, all of the Screens that are linked to that 
Edge Blend will be locked together in the Workspace Editor, so clicking and 
dragging on any of the Screens will move all of the linked Screens. 

When you select an Edge Blend the Screens pane on the right will change to allow 
you to control your Edge Blend. 

Configured Screens 

When you create an Edge Blend the Configured Screens 
pane will update to list the Edge Blend as its own object 
and list the defendant screens below the Edge Blend 
name. 
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Properties 
 
If you have an Edge Blend selected then in the 
Properties pane you can edit the Mode of the Edge 
Blend by selecting Linear, Cubic, or Quadratic from 
the drop-down menu. The Radius and Intensity of the 
Edge Blend can also be adjusted as needed. 

If you have selected an individual screen inside of an 
Edge Blend then the Properties tab will add a Gamma 
and Black Level option; these options will affect the 
overall look of that Screen. 

Blend Areas 

To adjust the amount of area that will be blended, select the Edge Blend and either 
manually adjust the number in the Blend Areas tab or click and drag the blue 
circles on the edges of the blue rectangle that represents the blended area. 

Note that if all of your Edge Blended Screens are the same resolution, then any 
Blend Areas listed will be the same; however if there are Screens of different 

resolutions then the Blend Areas will automatically adjust and show different values. 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Targets 
Targets are where your content will play. You will first 
set up a Target Set (which is a group of Targets), then 
set up your individual Targets. After you set up your 
Targets you will need to apply each Target Set to a 
Layer (which will be covered in the Layers section). Click 
on the Targets tab in the Workspace Editor to get 
started. 

Target Set 

Target Sets are groups of Targets that you will then 
later attach to a Layer to show back the content. 

Note that the functionality of Target Sets is very 
different between PVP 2 and PVP 3. In PVP 2, Target 
Sets were an optional feature that was a subset of 

Targets. In PVP 3, Target Sets are required; you can’t 
have a Target unless it is inside of a Target Set. 

Configuring Target Sets 

To create a new Target Set, click on the drop-down menu and select Create new 
Target Set… To select a different Target Set, click on the drop-down menu and click 
on the desired Target Set. Click on the trash can   to delete the currently selected 
Target Set. 

Change the text in the text box to rename the current Target Set. To change the 
color of the Targets inside of a Target Set (the color of the outline as well as the 
internal color of the Target if you are using the default Test Image) click on either 
the color box (to select from a pre-defined set of colors) or the color wheel (to 
select a custom color). 
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Advanced 

By default your Targets will feature a Test Image that 
features a grid, circles, and lines to help you identify 
your Targets. To customize this Test Image, click on the 
disclosure triangle   next to Advanced in the Target Set 
window. 

The Size option will allow you to adjust the render 
resolution of the Test Image. Use this to adjust the grid 
size of the Test Image (as an example). 

There are multiple default patterns that you can choose from inside of PVP. Click on 
Configure Test Pattern to select a built-in pattern or to customize the pattern that 
you have selected. Here are the patterns you can select from: 
• Blend Grid (default) 
• Color Bars 
• Focus 
• Gray Scale 
• Black Color 
• White Color 
• Custom Color 

To set your own Test Image click on the drop-down menu next to “Test Image:” and 
select Custom, or drag a still image from the Finder on top of the image below the 
drop-down menu. You can always select a different Custom Image or go back to the 
Default image. 

We recommend a .jpg or .png file for use as your Test Image, 
however this feature will support a wide range of still image file formats. 

Identify Target 

Sometimes it is helpful to identify where your Targets are showing on the actual 
devices themselves. Clicking on the Identify Targets button will overlay the Test 
Image on top of the Outputs so that you can visually see how the Targets are set. 
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This is rendered in real time so you can turn on the feature and click and drag your 
targets around to see what they will look like as you drag them. 

Note that your Output must be turned on (Command-1) 
to use the Identify Targets feature. 

New Targets 

Inside of each Target Set you can have as many Targets as you would like. 

Under Identify Targets you can select one of the buttons to create a new Target in 
one of four shapes: Rectangle, Ellipse, Custom, and Image. 

Rectangles and Ellipses (sometimes called Ovals) are pretty straightforward; they 
have a Height and a Width and a position (X and Y coordinates on the Canvas). To 
create one of these Targets, click the Rectangle Target button   or the Ellipse 
Target button   and a Target will be created. (PVP will guess where you want the 
Target to be created, but you can always move and resize the Target as needed.) 

The Custom Target tool   allows you to draw your own Targets via a Pen tool. To 
create one of these Targets, select the Custom Target tool then click on anywhere in 
the Canvas; this will set your first point. You can then click additional points to make 
corners in your Target. If you click and drag a point it will create a bezier curve. 
When you are done with your shape, press Escape on the keyboard, click on the 
first point again or double-click the mouse to close the shape. 

If you need to edit the Custom Target after it was created, double-click on the edge 
of the Custom Target and you can adjust your points as needed. 

The Image Target tool   allows you to import an image to use as your Target 
shape. PVP will use the Alpha channel (transparency) of the image to create a 
Target Shape. 

We recommend a .png file with transparency for use as your Image Target, 
however this feature will support a wide range of still image file formats. 
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If you want to create a Target that fills a Screen then there is a quick tool for doing 
that: Right-click on a Screen and choose Add Target to [Screen]. This will create a 
Rectangle Target that fills your Screen edge to edge. 

Target List 

Below the New Target buttons is the Target List 
(labeled as “Targets”). This window will list all of the 
Targets in the selected Target Set as well as show you 
which order they are in. You can select a specific Target (say, if one is behind 
another one) by clicking on its name in this list. To reorder the Targets in the Target 
Set, click and drag the desired Targets to a new location in the list. 

Target Properties 

To adjust the properties of a selected Target head to 
the Target Properties window. You can change a 
Target’s name by typing a new name into the text box. 
Select and type new numbers or use the arrow buttons 
to manually adjust the Position (X and Y coordinates) 
and Size (Width and Height) of a selected Target. 

Next to Aspect Ratio it will show the Target’s aspect 
ratio. Click Locked to lock the aspect ratio of a Target. 

To rotate a Target, type in a new number or use the arrow buttons next to 
Rotation.  Click the Vertical Flip or Horizontal Flip button to flip the content in the 
Target. To feather the edges of a Target, use the slider, type in a number, or use the 
arrow buttons next to Feathering. Click the Reset button to reset the properties 
back to default. 
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Custom Scale Editor 

There may be an instance where you want to have a Target that automatically crops 
an image or adjusts it to a different aspect ratio than what the Target itself has. You 
can use the Custom Scale Editor to get this result. 

Note that you can use the Custom Scale Editor to crop the edges of media 
that plays inside of a Target, however it cannot be used to make 

the media smaller inside of the Target. 

Open the Custom Scale Editor window by pressing the 
Adjust button at the bottom of the Target Properties 
window or by double-clicking on a Target. (The Custom 
Scale Editor will appear below the Target Properties 
window.) 

To visually adjust the Custom Scale, click and drag one of the black bounding boxes 
at the edges of the Target. (Remember that you can only drag the boxes away from 
the Target, you cannot make them smaller than the Target itself is.) You can also 
type in custom numbers or use the arrow buttons to manually adjust the Position 
and Size of the Custom Scale. You can see the current aspect ratio as well as lock 
the aspect ratio at the bottom of the Custom Scale Editor window. 

To reset the Custom Scale back to the default settings, click the Reset button. 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Masks 
There may be setups where you want to mask the output of PVP so that it doesn’t 
show an image where you don’t want it to. For example you may need to mask a 
projector that is overshooting your intended area, or you may need to mask around 
an architectural feature where you want nothing projected. 

The Mask feature of PVP allows you to cover up a part of your Master Output so 
that no content is shown in that area 

Note that while the Mask feature allows you to set colors of your Masks, 
this is only for organizational purposes. All Masks inside of PVP will output 

as a solid black overlay on top of your Output. 

You can create as many Masks as you want, but only one Mask may be active at any 
given time. In addition to that, each Mask is made up of one or more Shapes; these 
Shapes control where the Mask will show on your devices. 

Mask Management 

If you do not have any Masks created (such as when 
you are setting up your first Show), when you click on 
the Mask tab in the Workspace Editor you will see a 
button that says Create New Mask. Click on this 
button to create your first Mask. 

To create additional Masks, click on the drop-down menu and select Create new 
Mask. To select a different Mask, click on the drop-down menu and click on the 
desired Mask. Click on the trash can   to delete the currently selected Mask. 

Change the text in the text box to rename the current Mask. To change the color of 
the Mask click on either the color box (to select from a pre-defined set of colors) or 
the color wheel (to select a custom color). 
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Click on Identify Masks to show the currently selected Mask on the output with the 
names of the Shapes; this may help in aligning or otherwise setting up your Shapes. 

Selecting the Overlay button will set the Mask so that the shapes cover up 
whatever image is below it. Select Keyhole to invert the mask so that the shapes 
are the portion of the image that is showing and the rest of the output will be 
covered up. 

New Mask Shapes 

Masks are made up of one or more Shapes that control where the Mask will be 
shown on the screen. The leftmost button in the Mask Shapes row is the Selector 
Tool   ; this tool allows you to select one or more shapes in the Editor. 

Next to the Selector tool are four buttons for creating shapes inside of the currently 
selected Mask: Rectangle, Ellipse, Custom, and Image. 

Rectangles and Ellipses (sometimes called Ovals) are pretty straightforward; they 
have a Height and a Width and a position (X and Y coordinates on the Canvas). To 
create one of these shapes, click the Rectangle Mask button   or the Ellipse Mask 
button  , then click and drag on the Canvas to create the Shape. 

The Custom Mask tool   allows you to draw your own shape via a Pen tool. To 
create one of these shapes, select the Custom Mask tool then click on anywhere in 
the Canvas; this will set you first Point. You can then click additional points to make 
corners in your shape. If you click and drag a point it will create a bezier curve. 
When you are done with your shape, press Escape on the keyboard, click on the 
first point again or double-click the mouse to close the shape. 

If you need to edit the Custom Mask after it was created, double-click on the edge 
of the Custom Mask and you can adjust your points as needed. 

The Image Mask tool   allows you to import an image to use as your Mask shape. 
PVP will use the Alpha channel (transparency) of the image to create a mask. 

We recommend a .png file with transparency for use as your Image Mask, 
however this feature will support a wide range of still image file formats. 
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Mask Shapes List 

Below the New Mask Shape buttons is a list (labeled as 
“Masks”) of all of the Shapes that are inside of the 
currently selected Mask. You can select a specific shape 
(say, if one is behind another one) by clicking on its 
name in this list. To reorder the shapes in the Mask, 
click and drag the desired shapes to a new location in 
the list. 

Mask Properties 

To adjust the properties of a selected shape head to the Mask Properties window. 
You can change a shape name by typing a new name into the text box. Select and 
type new numbers or use the arrow buttons to manually adjust the Position (X and 
Y coordinates) and Size (Width and Height) of a selected Shape. 

Next to Aspect Ratio it will show the shape’s aspect ratio. Click Locked to lock the 
aspect ratio of a shape. 

To rotate a shape click on the circle, type in a new number, or use the arrow 
buttons next to Rotation. To feather the edges of a shape, use the slider, type in a 
number, or use the arrow buttons next to Feathering.  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Layers 
Layers are capsules for how to control the playback of 
your media. A layer can have a Target Set selected 
(which is how it determines where the media will play); 
in addition to that, you can control many other 
properties and effects of the media that is playing 
through that Layer. 

Your Layers are listed across the top of the primary PVP 
interface. Each Layer has a name as well as a color 
associated with it for organizational purposes. Below the Layer’s name is a preview 
of the media that is currently playing back in that Layer. 

Select and Target a Layer by clicking on its name. If the Sidebar is enabled (by 
clicking on the Sidebar button   on the top right of the screen) you can access 
and edit the properties of the currently selected Layer inside the Sidebar. 
Additionally you can click on the disclosure triangle   next to Layer Details (on the 
left side of the Layers bar) to expand the details for each layer to see and make 
changes to all of the layers in the same area. 

Selected vs. Targeted Layers 

There is a, important distinction to make 
between Selecting a Layer and Targeting a 
Layer. A Selected Layer (indicated by a black 
frame around the Layer’s name) will be the 
layer that appears in the Sidebar whereas a Targeted Layer (indicated by a green 
frame around the Layer’s name) is where media which has no specific target will 
play. 

In a standard setup the Selected Layer and the Targeted Layer will be the same; 
left-click on the name of any Layer and it will both Select it and Target it. However 
there will be times where you want to Select one layer (to have it in the Sidebar, as 
an example) while having a different Layer Targeted. 
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To temporarily Select a Layer without Targeting it, hold the Command key while 
clicking on the Layer’s name; this Layer will stay Selected until you Select (such as by 
left-clicking) on another Layer. 

You can also Lock a Layer as Selected. One way to Lock a Layer would be to Option-
click on that Layer; this will both Select and Target the Layer, but it will mark this 
Layer as Locked, meaning when you click on another Layer it will only Target it. You 
can also go to the menubar and select Layers > Lock Layer Selection > [Layer] or 
hold the Option key and press the number (1-9) corresponding to a given Layer and 
it will Lock that Layer as being Selected. Option-Click the Locked Layer or select 
Layers > Lock Layer Selection > None to turn off the Lock feature. 

Note that when any Layer is Locked as the Selection, 
left-clicking will only Target the clicked on Layer.  

In addition to this, the Master Layer can be Selected, but it can never be Targeted. 

Layer Management 

To Rename a Layer, Change the Color of a Layer, or Delete a Layer, right-click on 
the name of the Layer and choose the appropriate option from the menu. 

There are two ways to create a new Layer. To create a new Layer on the far right of 
the Layer stack (it will be the “last” Layer), click on the + button on the left of the first 
layer. Alternately you can right-click on a Layer’s name and select Insert New Layer 
to add a Layer to the left of that Layer. 

Note that you can have up to 23 Layers at any given time. 

To move a Layer, right-click on that Layer and select Move, then select where you 
want the Layer to move to. 

Note that the process of moving a Layer will first clear all media from all Layers. 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Mute, Hide, and Clear 

Sometimes you want to mute the audio or hide the 
video for a specific Layer, and other times you want to 
clear the media that is playing inside of a Layer. To see 
these functions you can hover your mouse over the 
media preview for that Layer. 

Click on the Mute button   to mute the audio of whatever media is being played in 
that Layer. Click the button again to unmute the audio. 

Click the Hide button   to hide any visual media that is being played in that Layer. 
Click the button again to show the visual media. 

Click on the Clear button   to clear the media that is currently loaded in that layer. 
This removes the media from that layer; to show it again you would have to fire the 
media again. 

Note that when a Layer is muted/hidden, there will be 
a visual indicator next to the name of the Layer. 

All of these functions are also available via the Master Layer, which in turn controls 
all other Layers. That is, if you Mute or Hide in the Master, then the entire output of 
PVP will be muted/hidden and Clearing the Workspace will remove media from all 
Layers. 

Playback Controls 

Below the preview are some Playback Controls to control video and audio that is 
playing in that Layer. Use the Play/Pause button   /   to pause or play the media, 
or use the Skip Backwards/Forwards buttons   /   to skip backward or forward 
15 seconds. 

Use the Go To End button   to skip directly to the end of the media; this is helpful 
if you want to jump directly to the End Behavior of the media such as looping a 
video back to the beginning or going to the next piece of media. You can also right-
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click (or click and hold) on the Go to End button and choose how far from the end 
you want to jump to (90 seconds, 60 seconds, 30 seconds, 10 seconds, or directly to 
the end). 

If you have the Sidebar open (by clicking on the Sidebar button   on the top right 
of the screen) you will see all of these features plus an additional Go To Beginning 
button   which you can similarly right-click on (or click and hold) and choose a 
length from the beginning that you want it to jump to. 

Note that when you change the Go To Beginning or Go To End time, 
all instances of that button across PVP change to match the new setting. 

Layer Presets 

Layer Presets allow you to create a pre-
configured list of settings for your Layers; this 
provides a way for you to set up all of the 
settings for a Layer and save those settings for 
later recall. 

To create a Preset, first set up your Layer with all 
of the features in the settings that you want it to 
be saved in, then select the drop-down menu in 
the Preset area and choose Save As… This will 
show a window where you can name your 
Preset. Once you save your Preset you can 
choose the Preset drop-down menu in any Layer 
and select your saved Preset; when selecting a Preset the Layer’s properties will be 
updated to match that Preset. 

If you have a Preset applied to a Layer and you change a property of that Layer 
then the Preset will be marked as “changed” by showing an asterisk * next to the 
name of the Preset. If you want to update the Preset to save these changes you can 
click on the Preset drop-down and choose Save. 
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You can click on the drop-down menu and select Unlink Preset to remove the link 
to the Preset. To delete a Preset, click on the drop-down, hover your mouse over 
the name of the Preset, and select Delete. 

Target Sets 

The Target Set is where the media will play on your screens. Click the drop-down 
menu to select which Target Set will be applied to this Layer. You can also select 
None to have no Target Set selected (such as if you want a Layer to be audio only). 

For more information on how to create and edit Target Sets see the Target Set 
section under the Workspace Editor heading. 

Blend Modes 

PVP 3 offers the ability for Layers to have a Blend Mode. This means that Layers 
can interact with other Layers in creative ways. Specifically you can set a Blend 
Mode which will have the given Layer interact with the content that is showing 
below that Layer. 

Explaining how each Blend Mode interacts with the content below it 
is outside the scope of this User Guide; there are many such guides online 

that can inform you as to how to get the look you are wanting by using 
Blend Modes, or experiment and create your own unique looks! 

To select a Blend Mode, click the drop-down menu and select the desired Blend 
Mode. To reset this feature, click the drop-down menu and select Normal. 

For a list of the Blend Mode that PVP offers reference the Appendix. 

You can also adjust a layer’s Opacity so that it can be transparent (0%), opaque 
(100%), or somewhere in between. 

Matte Blend Modes are available for showing transparency from one layer to the 
next.  More information on this can be found in our KnowledgeBase here. 
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Effects 

You can apply one or more Effects to your 
Layers to customize how the Layer will display on 
the output. You can manually add individual or 
multiple Effects to each Layer (there is no limit to 
the number of Effects that can be on a layer), or 
you can use Effect Presets to apply multiple 
Effects onto a Layer at once. You can also select 
how long it will take for the Effect(s) to transition 
onto the output. 

To create an Effects Preset, first set up your 
Layer with one or more Effects, then select the 
drop-down menu in the Effects Preset area and 
choose Save As… This will show a window where you can name your Effect Preset. 
Once you save your Effect Preset you can choose the Effect Preset drop-down 
menu in any Layer and select your saved Effect Preset; when selecting an Effect 
Preset the Layer’s Effects will be updated to match that Effect Preset. 

If you have an Effect Preset applied to a Layer and you change an Effect of that 
Layer then the Effect Preset will be marked as “changed” by showing an asterisk * 
next to the name of the Effect Preset. If you want to update the Effect Preset to 
save these changes you can click on the Effect Preset drop-down and choose Save. 
If you want to save this version as a separate Effect Preset, click on the Effect Preset 
drop-down and select Save As…; enter a new name and a new Effect Preset will be 
created. 

To remove all Effects from a Layer click on the Effects Preset drop-down and select 
Remove All. To see all of the Effects that are inside of an Effect Preset, click on the 
Effect Preset drop-down and hover your mouse over the name of the Effect Preset. 
To delete an Effect Preset, click on the Effect Preset drop-down, hover your mouse 
over the name of the Effect Preset, and select Delete. 
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To change the length at which the Effect will transition onto the screen adjust the 
Effects Build Duration by dragging the slider or, in the Sidebar, manually entering 
a number into the box. 
To add an Effect, hover your mouse below the Effects Build Duration slider and 
click the + button, then select the desired Effect. Once you have added an Effect to 
a Layer you can temporarily toggle an Effect by clicking the checkbox next to the 
name of the Effect. Click the down arrow   to the right of the Effect name and 
select Remove Effect to remove the Effect, or select a different Effect to change 
that Effect to a different Effect. 

Many Effects have parameters that you can adjust. These parameters are 
automatically shown in the Sidebar; in the Layer Strip you can click on the name of 
the Effect to access these parameters. 

For a list of the Effects that PVP offers reference the Appendix. 

Transitions 

Each Layer can have its own Transition applied to it. If you apply a Transition to a 
Layer then any media that is played in that Layer will use the appropriate Transition 
instead of the Transition that is selected in the Master Layer. 

  

Note that a Layer’s Transition will trump the Master Transition, however if the 
Media that you fire has its own Transition then this, in turn, will trump the Layer 

Transition. 
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In the Sidebar the Transition preview and its parameters are always available to be 
viewed and edited. In the Layer Detail view click on the name of the Transition to 
view these features. 
Click on the Transition Drop-down (will either be labeled “Default” or have the name 
of the currently selected Transition) to see a list of the available Transitions; click on 
one to select it. Scrub your mouse over a Transition preview to see a preview of 
that Transition. 

On the top left of the Transition Drop-down you can click on the Sort By drop-down 
to limit the list to only a sub-section of Transitions. Type a phrase in the Filter field 
to search for available Transitions. In addition to an organizes list of available 
Transitions there is also at the top of the list your Favorite Transitions and Recent 
Transitions. (To clear your Recent Transitions, click on Clear to the right of the 
Recent Transitions section.) 

Some Transitions have parameters that you can adjust; when present these 
parameters are always shown in the Sidebar; to access them in the Layer Strip you 
can click on the Transition Drop-down and the parameters will be shown on the 
right side of the drop-down. Click on the star to create a Favorite Transition. 

Click the Use Master Transition button   to toggle the custom Transition for that 
layer; this will set the Transition to “Default" which will allow future media to use 
the Master Transition again. 

For more information about Transitions visit the Transitions section. For a list of the 
Transitions that PVP offers reference the Appendix.  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The Master Layer 

The Master Layer is a unique Layer which controls the 
overall output of PVP and thus offers you several 
controls above and beyond a normal Layer. 

The Master Layer preview shows you all of your Screens 
at the same time. This allows you to see a quick and 
clear overview of your entire Show. 

Hovering over the preview of the Master will show you 
the standard Mute   and Hide   options which, 
when clicked, will toggle all of the audio/media in the 
entire Show. Similarly, the Clear Workspace   and the 
playback controls will affect all Layers; this allows you 
to, for example, pause all of your videos at the same 
time or clear all of your Layers with one click. 

Click the Output Status: button (or press Command-1) 
to toggle your output on and off. When the output is 
turned on there will be a green light next to the Master 
title which will indicate that your output is on and 
working; if this tally light is missing then your output is turned off. 

Selecting a Mask on the Master Layer will apply that Mask to your entire output; 
any time the Mask feature is enabled, PVP will display a Mask icon   next to the 
Master Layer name to remind you that you have Masks enabled. 

The Master includes an Effect feature that applies selected Effects to the entire 
output. This section follows all of the same rules for standard Layer Effects; see that 
section for more information. 

You also select your Default Transition in the Master Layer. This is the transition 
that will be used for all Media and Layers (unless it is overridden for a given Layer 
or media item, see the Transitions section for more information). See the Layer 
Transition section for information on how to use this feature. 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Playlists 
The left column of PVP is devoted to Playlists, each of which 
contains Actions (for telling PVP what you want to do) and 
your Cues (for firing one or more Actions at the same time). 
You can create multiple Playlists for organizing your Actions 
and Cues so that related items are grouped together. 

Playlist Types 

There are three types of items that you can create in the 
Playlist area: 

Playlists 
A standard Playlist   is a container for holding your media Cues and Actions. 
Create as many Playlists as you want to best organize your content. 

Smart Playlists 
A Smart Playlist   will look at a folder on your computer and always keep your 
media up to date based on what is in that folder. 

For example, let’s say you have your media already organized into a folder on your 
computer. You can add this folder into PVP as a Smart Playlist at which point PVP 
will actively look at that folder and relay its contents into your Smart Playlist. Any 
media that is added or deleted from the folder on the computer will automatically 
be similarly changed in your Smart Playlist. 

Groups 
A Group   is a folder to organize your Playlists. You cannot add Actions or Cues 
into Groups directly, you can only add Playlists, Smart Playlists, and other Groups 
into a Group folder. 
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Managing Playlists 

To add a Playlist click the + button at the bottom left of the Playlist area or right-
click on a Playlist and select New, select which type of Playlist you would like to 
create. Press Command-N to create a new standard Playlist. To rename a Playlist, 
right-click on the playlist and choose Rename. To delete a Playlist, select it and 
press the delete key on your keyboard or right-click on the item and choose Delete. 
Duplicate a Playlist by right-clicking on the Playlist and selecting Duplicate or by 
pressing Command-Shift-D. 

Secondary Playlist 

Sometimes you want to have two different Playlists open at the same time so that 
you can fire content from different areas, or maybe you want to be able to see two 
separate locations inside of one Playlist at the same time. In PVP 3 we added a 
feature called Secondary Playlist which allows you to do precisely that. By holding 
the Option key while clicking on a Playlist or, in the menubar, selecting Playlist > 
Secondary Playlist > [Playlist], it will open that playlist in a secondary window below 
the primary Playlist for extra access to your content. 

  
You can choose between a horizontal or vertical orientation of the Secondary 
Playlist by selecting in the menubar Playlist > Secondary Playlist Orientation. Close 
the Secondary Playlist by clicking on the   in the top right of the Secondary Playlist 
or, in the menubar, selecting Playlist > Secondary Playlist > None. 

Page   of  55 92



Video Input Playlist 

The Video Input Playlist can be accessed by clicking on the   Video Input button 
on the bottom of the Playlist area. This is a custom playlist type that will show live 
previews of all of your Video Input Actions. This allows you to see all of your video 
input feeds at once and fire them directly as needed. 

Note that video inputs will show live previews while inside of the Video Input 
Playlist, however they will not show live previews if you copy                                           

the Actions to other playlists. 

Add Video Inputs to the Video Input Playlist by clicking the + in the lower left and 
selecting your desired Input.  If you have not created an Input, you will be directed 
to Video Input Setup from the + menu.   

Video Input Setup is done in the Video Input tab of PVP Preferences.  For 
information on defining your inputs, reference the Video Input Setup section.   

Set Targeting Layer 

By default media that has not been attributed to a specific Layer will play in the 
currently Targeted Layer. Setting a Playlist’s Targeting Layer will override this 
function and assign a specific Layer for any media that is not already assigned to a 
specific Layer. 

To assign a Targeting Layer to a Playlist, right-click on the Playlist and select Set 
Targeting Layer, then select the Layer in which you want the media to play in. You 
can also select the desired Playlist then, in the Menubar, select Playlist > Set 
Targeting Layer, then select your desired Targeted Layer. This will show a bar to the 
right of the Playlist name matching the color of the Layer that is Targeted so that 
you can easily see which Layer the media will play in. 

To turn off this feature for a Playlist, repeat the above steps but choose Current 
Layer to return the function to the default setting. 
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Timecode 

PVP can listen to a Timecode signal and fire Cues at a specific Timecode frame so 
that you can set your Show to fire all necessary media at the precisely correct time. 

To assign a Timecode to a specific Playlist, right-click on the Playlist and choose 
Timing, then choose Timecode. You can then head to the Cue View to assign the 
Timecode to the necessary Cues. Right-click on a Playlist and choose None to turn 
off this feature. 

To find out how to set up and use these features please see the Timecode section.  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Cue/Action View 
The Cue/Action View area is where most users will spend most of their time during 
an actual event/show. This is where you import media, create Cues assign them to 
Layers, and set up and run your Shows! 

First, we want to differentiate between Cues and Actions. Actions are specific 
individual actions that you want PVP to perform; Cues are groups that can fire one 
or more Actions at the same time. It is possible to perform some Actions manually, 
but usually you will put your Actions into a Cue. For example: If you import a piece 
of media into PVP, it is automatically bundled into a Cue with a single Action (to play 
the media); from there you can click on the Cue to fire it (to show the media) or you 
can add other Actions to the Cue to further customize the Cue. 

Actions 

Actions are individual actions that you perform inside of PVP. This can be firing a 
piece of media, clearing a Layer, assigning an effect to the Master, or one of many 
other actions. 

Types of Actions 

Here is a list of Actions that you can choose from: 

Media Actions

• Play media to a predefined Layer
• Play media to a Targeted Layer

Layer Actions

• Clear
• Mute
• Unmute
• Hide
• Unhide
• Assign a Layer Preset
• Assign a Target Set
• Assign a Blend Mode
• Assign an Opacity
• Assign an Effets Preset
• Assign an Effects Duration
• Assign an individual Effect
• Assign a Transition
• Fire Cue from a Playlist

Workspace Actions

• Clear All
• Mute All
• Unmute All
• Hide All
• Unhide All
• Clear Mask
• Assign a Mask
• Assign an Effects Preset
• Set an Effect Duration
• Set an individual Effect
• Assign a default Transition
• Fire Cue from a Playlist
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Cues 

A Cue is a trigger for one or more Actions, including visible Actions and non-visible 
Actions. Think of them as groups of Actions that fire at the same time. You can add 
as many Actions into a single Cue as you would like, and you can always edit each 
Action as well as customize the Cue itself. 

Cues may be referred to as Single-Action Cues or Multi-Action Cues 
depending on how many Actions they contain. 

To fire a Cue, simply click on it. You can also type the number of the Cue (using your 
keyboard) and press enter. 
 
To create a cue click the + button at the bottom left and select one of the options 
there (From Finder, From Video Input, Snapshot, or Empty Cue) or drag media 
from the Finder into PVP. 

Cue Thumbnails 

Each thumbnail is a wealth of information about that 
Cue. The main area of the thumbnail will show you any 
media that will be playing back when you fire that Cue. 

In the top right it will show you the length of the Cue 
(how long the Cue will play). For example, if you have one video clip that is 30 
seconds long in the Cue and the video clip is set to Stop, then the top right will 
show “00:30:00” (meaning the Cue will play for 30 seconds and then stop). If that 
same video is set to Loop then the Cue will have an infinite duration and thus will 
show the infinity sign: ∞. There is also an icon in the lower left that will tell you how 
your media will be scaled when you click on it. (See the Scale Behavior section to 
find information on the icons and what they represent. You can turn these icons off 
by unchecking Show Scaling Icons in the General tab of Preferences.) 

If you have your media assigned to a specific Layer (or to multiple Layers) then the 
color of those Layer(s) will show across the bottom of the Cue; across the top of the 
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Cue you will see similar color bars (called “pills”) if the media in the Cue is currently 
being played back in a Layer. 

Snapshot 

Say you have multiple Layers with media playing back in the different Layers, and 
you want to save this “look” out as a Cue. The Snapshot feature was designed to do 
this that! 

To create a Snapshot, click on the “+” icon in the lower left of the 
Cue or Action View and select Snapshot. When you do a window 
will pop up showing your available Layers as well as your Master 
Layer. 

For any Action that is currently active that you want to save to 
your Snapshot Cue, click on the appropriate box. For example, 
you could click on the boxes for the Media in Layer 1 and 2, then 
click the box for Target Set in Layer 1 and the Mask for Master; 
once you click on Save it will select the current setting for each 
of those selected boxes and save them out as a Cue, ready for 
replaying at any time! 

Navigating the Cue/Action View 

In the top left of the Cue/Action View, click on the Playlist button   to open a drop-
down where you can jump directly to any Playlist. Use the arrows to the left of that 
button to browse (backward and forward) through the Playlists that you have 
recently viewed. 

Across the bottom click on the magnifying glass   to Search your Cues; type in any 
text and the Cues that match that text will be shown accordingly. On the bottom 
right there is a slider that controls how large the thumbnails are in the view. 

The Cue View 

The Cue View (enabled by clicking on the “Cue” toggle   on the right side under 
the Master Layer) is the default view in PVP and it shows an overview of all of the 
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Cues that are inside of your currently selected Playlist. To fire a specific Cue simply 
click on it and it will fire all of the Actions that are inside of that Cue. 

The Action View 

The Action View (enabled by clicking on the “Action” toggle   on the right side 
under the Master Layer) is an alternate way to view, organize, and fire Actions and 
Cues. 

  

Each Cue in the currently selected Playlist will show up as a row (the thumbnail of 
the Cue will be on the far left, next to the Playlist window). Across the top (forming 
columns) will be a list of Layers. The middle area is a grid where you can fire specific 
Cues to specific Layers without having to select a given Layer. Let’s look at the 
different columns for the Action View. 

Cues 

On the left-hand side of the Action View it will list all of your Cues that are in the 
currently selected Playlist. The thumbnails that are in the Cue Column are the same 
thumbnails that are shown in the Cue View, and anything you could do to the Cues 
in the Cue View you can do in the Cue Column of the Action View; for example, to 
fire any Cue simply click on it in the Cue Column. 
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The contents of each row represents the Cue that is shown in the left column; 
that is to say the left column shows an overview for the Cue while the rest of the 

columns show the Actions that make up the content of that Cue. 

Untargeted 

The Untargeted column shows media that is inside of a Cue that has not been 
assigned to a Layer. Click on the media to show it to the currently Targeted Layer. 
To assign an Untargeted media to a specific Layer you can click and drag it to the 
column of the desired Layer. You can also right-click on an Untargeted piece of 
media to manually Assign it to the desired Layer as well as Removing the Action 
and a plethora of other options. 

Layers 

The main section of the Action View is a series of columns that represents each 
Layer (including the Master Layer) that you have in your Show. This is not only a 
visual indicator of where media is assigned, it is also an easy way to assign and 
organize your media into Cues as well as fire specific media to specific Layers. 

Thumbnails that are opaque represent Media Actions that are assigned to that 
specific layer. Click and drag Media Action thumbnails (including Untargeted 
thumbnails) to a Layer where you want it assigned. To duplicate an assignment (for 
example if you want one piece of media playing in two different layers when you 
click on the cue) hold the Option key down when you click and drag. 

Thumbnails that are semi-transparent represent Media Actions that will play in that 
Layer if they are clicked on. This will happen in two instances: 
• There is one Untargeted media Action and no targeted media Actions; in this case 

the media will appear as a transparent thumbnail under the currently selected 
Layer, or 

• If there is only one media Action assigned to a Cue (be it targeted or not) and you 
hover your mouse over a space that does not already have an Action in it. 

In any case (opaque or transparent) you can click on a thumbnail to fire it directly to 
that Layer. 
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To make a transparent Action opaque (that is, to assign it to that Cue) you can click 
and drag an opaque Action (including from the Untargeted area) to where you want 
it to be assigned. 

In addition to Media Actions, you can also perform many of the same functionality 
with Non-Media Actions (see Types of Actions for a list of Non-Media Actions). Click 
the + button in any cell (will be below the thumbnail if there is Media already in that 
cell) to see a list of Actions that you can add to that cell. Once an Action is added to 
a cell you can right-click on the Action to adjust its properties (if present) or to 
Remove it if needed. 

To move all Actions from one Layer to another, click and drag any Action to a new 
Layer. If there are multiple Actions on one Layer and you only want to move one of 
the Actions, Command-click and drag that Action to a new Layer. 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The Inspector 
The Inspector is an in-depth window for editing the properties for your Cues and 
Media Actions. This is the go-to place for customizing how your Cues and Media 
Actions will look, play, and act when you click on them. 

  

To open the Inspector to a Cue, right-click on a Cue and select Inspector… To jump 
straight to editing one of the Media Actions inside of that cue you can right-click on 
the Cue, hover your mouse over Inspector…, then select the Media Action that you 
would like to edit. 

You cannot add/edit/remove non-Media Actions via the Inspector. 

Cue/Media Action List 

Inside of the Inspector the far left area is the Cue/Media 
Action List. This will list any Cues that you had selected 
when you opened the Inspector, as well as any Media 
Actions that are inside of those Cues. 

Click on a Cue or a Media Action in the list to select it and 
edit its properties.  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Preview Pane: Cue 

When a Cue is selected the main Preview 
area will show you the same “preview” as 
its thumbnail; that is, it will show you an 
overview of all of the media that is inside 
of that Cue. 

Across the top it lists the Cue’s name. To 
edit the name, click on the name and 
enter a new name. 

Preview Pane: Media Action 

When a Media Action is selected the Preview Pane offers a place for you to 
customize the settings for your Media. 

Across the top it lists the name of the 
Media Action. By default this is the name 
of the file, however if you would like to 
change this then you can click on the 
name and enter your own name. On the 
top right is a Layer Assignment drop-
down menu; to change which Layer this 
media will play in click the drop-down 
menu and select the appropriate Layer. 

The main preview area will show you a 
preview of your media. If the media is a 
video or audio then use the scrubbing bar to jump the preview to a specific place 
in your media. Below the scrubbing bar are some Playback Controls to control the 
playback of the media. Use the Play/Pause button   /   to pause or play the media, 
or use the Skip Backwards/Forwards buttons   /   to skip backward or forward 
15 seconds. 

Click the Step Backward/Forward buttons   /    to step frame-by-frame through 
your media. Use the Go To Beginning button   or Go To End button   to skip 
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directly to the beginning or end of the media. You can also right-click (or click and 
hold) on the Go to Beginning/End buttons and choose how far from the beginning/
end you want to jump to (90 seconds, 60 seconds, 30 seconds, 10 seconds, or 
directly to the beginning/end). 

To change the starting point of a video or audio move the playhead to the desired 
location and then click In to set the In Point. Similarly you can click on Out to set 
the Out Point. Click Reset In or Reset Out to reset the respective features. 

Edit Pane: Cue 

When a Cue is selected in the Inspector, the Edit Pane on 
the right will show two options. Completion Action 
controls what triggers the “end of the cue”; click on the 
drop-down to inform PVP when the Cue should end (the 
First Media Action that ends, the Last Media Action that 
ends, or a specific Media Action). The Next Behavior 
drop-down allows you to select what happens when the 
Cue ends (such as go to the Next Cue, a Random Cue, or 
a specific Cue). 

Note that the Completion Action option is only available if there is 
more than one Media Action inside of the Cue. 

Edit Pane: Media Action 

When you have a Media Action selected the Edit Pane on 
the right allows for fine-tuning your media by way of the 
Info, Properties, Effects, and Audio tabs. 

Info Tab 

The Info Tab has information about the media that you 
have selected. Across the top it lists the Action’s Name 
(which you can click on to edit) as well as the File Path to 
where the file that PVP is referencing is located. Click on 
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the magnifying glass   to open the location of the file in the Finder. If you want to 
change the file that PVP is linking to or to point PVP to a different copy of the same 
file, click on the gear icon   to open a Finder window where you can select a new 
file to reference. 

The Thumbnail feature will show you the thumbnail for the media. If your media is 
a video and you want to change the thumbnail, use the scrub bar in the Preview 
Pane to select the desired location then click Set to Current Frame. 

The bottom of the Info Pane will provide information about the media itself, such 
as its Type, Duration, Format, Size, and Frame Rate (FPS), depending on the type of 
media that is selected. 

Properties Tab 

The Properties Tab of the Inspector allows you to adjust multiple properties of 
your Media Actions. 
 
Click the drop-down menu next to Scale 
Behavior to adjust how the media will scale in 
your Target: 
• Scale to Fit   will make sure that all of your 

content shows within the bounds of a given 
Target and the media won’t be stretched; it 
will achieve this by adding black bars on the 
top/bottom or sides of the media as needed. 

• Scale to Fill   will keep your media not 
stretched and it won’t have any black around 
the sides or top/bottom; it will achieve this 
by cropping off the top/bottom or sides as 
needed. 

• Stretch to Fill   will fill the bounds of the 
Target with the media and it won’t crop any 
of the media out; it will achieve this by 
stretching the media as needed. 
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Change the Scale Alignment to control if the media will try to stay in the center of 
the Target or if it will tend towards one of the corners or sides of the Target.  Scale 
Alignment is only available if you set the Scale Behavior to Scale to Fit or Scale to 
Fill.  You can also enable Flip Horizontally and/or Flip Vertically to flip the media. 

Enable Crop to scale the media yourself to a subset of the original image. For 
example, if you wanted to show only the top left of a piece of media but have it fill 
the screen, you would adjust these numbers to do so.  Options for adjusting this 
are to enter numbers into the boxes as needed, use the arrow buttons next to the 
boxes, or use the black bounding boxes that surround the media itself in the 
Preview Pane. 

If you have a video or audio action selected then you can set the Playback 
Behavior which will affect what happens at the end of the media; depending on 
which Playback Behavior you select there may be other options available to you. 

For still images and video inputs, you can set the Duration (that is, how long it will 
show on the screen); videos and audio will have their Duration pre-filled. You can 
set the Delay Time which is how long the media will wait before it plays. For audio 
and video actions you can also set the Rate at which it will play (from 20% to 200%). 
 

If you set a Delay Time then the following icon will show on the thumbnail: 

At the bottom of the Properties tab you can select a Transition for non-audio 
pieces of media. This Transition will trump the Master Transition which allows 
media to have custom transitions which are unique to just that media. 

For more information about Transitions visit the Transitions section below. For a list 
of the Transitions that PVP offers reference the Appendix. 

Effects Tab 

The Effects Tab allows you to add and edit Effects to 
Images, Videos, and Video Inputs. Click the plus button to 
add an Effect to the media. Adjust an Effect’s properties 
by adjusting the options below that Effect (note that not 
all effects have properties that you can edit). To disable/
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enable an Effect click on the checkbox to the left of the Effect’s name. To change an 
Effect to a different Effect or to remove an Effect, click on the down arrow to the 
right of the Effect’s name. 

The Effects Preset allows you to assign a predefined set of Effects to a Media 
Action. If you have previously saved an Effect Preset you can use this drop-down to 
apply it. If you have applied an Effect Preset and you make changes you can Save 
those changes or Save As a new Preset. You can also use this drop-down to 
Remove All Effects from this media. 

For more information on Effects see the Effects section below. For a list of the 
Effects that PVP offers reference the Appendix. 

Audio Tab 

If you have a video selected which includes audio or you 
have an audio file selected then there will be an Audio 
Tab available to adjust the audio properties for that item. 

Under Transition Behavior you can add a Fade In and/
or a Fade Out to your audio. Check the boxes that you 
want to enable and adjust the slider to customize how 
long the fade will last. 

Click the Channel Routing button to open a window 
where you can route audio channels to specific outputs. See the Audio Routing 
section for more information. 

The boxes at the bottom of the Audio tab give you more insight into each audio 
channel. For each channel you can Mute or Solo the channel, you can Normalize 
the audio, and you can adjust the Volume. This area will also tell you which 
Outputs each channel is assigned to (which is set via the Audio Routing button 
above).  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Miscellaneous Features 
This section covers features of PVP that aren’t covered anywhere else as well as 
more information on some features that were touched on above. 

Audio Routing 

PVP allows you to route your audio to any output that the computer can see. For 
example, if you want all of your audio to go to a specific device or output, you can 
route it in the Preferences to go there. You can also route specific channels of audio 
to specific output channels. 

In addition to simple default setups (Channel 1 is Left, Channel 2 is Right, etc.), PVP 
is capable of fully customizing your audio setup. Clicking on Channel Routing in 
either the Preferences or the Inspector will bring up a window that allows this 
custom routing. 

This section will specifically cover how Audio Routing works; for more information 
on audio properties in general see the Preferences and Inspector sections. 

Audio Routing via Preferences 

The left side of the Audio Routing window 
shows you one PVP Channel for each 
Channel Count set in Preferences. Click on 
the channel name to rename it. To the right 
are 16 channels that you can output to. 

Note that not all devices support up to 16 channels. Selecting cells in columns 
higher than your device can support may result in unpredictable results. 

Click on the cells where you want the audio to be heard. For example, if you want 
PVP’s Channel 1 to output to Channel 3 of your output, click on the cell at the 
intersection of those two selections and the box will light up. To turn off a cell, click 
on it again. 
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Click on the M next to a channel to Mute that channel. Click S to Solo that channel. 
Click T to send a Tone to that channel. You can turn on and off as many of these 
features at the same time as you would like. 

In the top left you can click on the M to mute all of the channels. If you have one or 
more channels soloed, click the S in the top left to turn them all off at the same 
time. Click on the Mapping drop-down and select Auto to autofill the cells or Clear 
to remove all of the selected cells. 

Audio Routing via Inspector 

The Routing window that is accessible from the 
Inspector is more basic than the Preferences version, 
however the core functionality is the same. The left side 
lists all of the audio channels for the piece of media that 
is selected. The top lists the audio channels that are 
available in PVP (set up in the Preferences). 

Click on the cell of the row/column that you want the audio to play in. Click on the 
Mapping drop-down and select Auto to autofill the cells and Clear to remove all of 
the selected cells. 

AutoSave 

PVP 3 features AutoSave which means that all of your changes are saved 
immediately to file. You can still Undo actions that you want to undo, however once 
you quit PVP (or if PVP otherwise is no longer running) the Undo cache will be 
emptied and you will no longer be able to Undo any actions. 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Calendar 

The Calendar allows you to schedule Playlists to fire at specific times of the day 
including specific dates and/or reoccurring days of the week. This feature is great if 
you want a slideshow to change at a specific time or if you want a countdown to 
start five minutes before an event, just to name a few examples. 

  

Note that the Calendar feature is the latest iteration of what was 
called the Scheduler in previous versions of PVP. 

To open the Calendar feature, choose Calendar from the View menu or press 
Option-C. To disable all Calendar functions uncheck the Calendar Enabled 
checkbox across the top of the Calendar window, press Command-Option-S, or 
select Calendar > Enable Calendar from the menubar. (Note that these options are 
only available while the Calendar window is open.) 

The left side of the window will list all of your Events and the right side shows you 
information about the currently selected Event. If there is an Event that is currently 
active, you can select it by clicking the Current Event button  . The Show/Hide 
Reoccurring Events button   will toggle the left pane between showing only one 
copy of each event and showing all occurrences of all events. 
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Events 

An Event is a single or reoccurring Playlist or Action that fires at a given day and 
time. Note, though, that once the Event fires it is still considered “active” until 
another Event becomes active, you disable the Calendar feature, or you delete the 
Event. This means that if PVP is shut down and is later re-opened while the Event is 
still active, the Action that is associated with that Event will fire again. This is very 
helpful if you want PVP to auto-play an Action every time it opens. 

To create a new Event click on the + button in the bottom left of the Calendar 
window or from the menubar select Calendar > New Event. To delete an Event, 
select it in the Calendar window and press the delete key or, if you have a touch 
pad, you can use two fingers and swipe to the left on the name of the Event and 
then click Delete. 

If you are deleting an Event that has more than one occurrence then it will ask you 
if you want to delete only that one occurrence or all occurrences of the Event. 

You can customize an Event’s Name and Description on the top right of the 
Calendar window. Below that is where you set the Event’s scheduled time to fire; 
each Event must have a date and a time that it will become active. 

Next to Repeat you can select days of the week that you want the Event to repeat. 
If you select one or more days of the week then you can optionally set a date and 
time for the Event to End On. 

At the bottom of the window you can select the Action which will control what 
happens when the Event fires. This can be a Clear action or it can be the first Cue of 
a specified Playlist. Click on the Test button to immediately see what will happen 
when the Event activates. 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Master Layer 

The Master refers the entire PVP output and can be referenced in several ways: 
• The Master Output refers to everything that is being output from PVP; that is 

everything that the audience would see. 
• The Master Layer is a custom Layer which allows you to set custom settings that 

applies to the Master Output, such as Masks and Effects. 
• Master Transition refers to the default settings for Transitions that applies to all 

media that does not have an override on the media itself or on the Layer that it is 
playing back in. 

Note that the words “Master” and “Workspace” can be used interchangeably. 

Monitor Output 
 
The Monitor Output allows you to send 
the entire PVP workspace to an external 
screen.  This is helpful in that you can see 
a larger preview of the full PVP workspace.   

To turn this option on, you will click on the 
Master Layer Strip and then will see a 
dropdown for Monitor in the Sidebar 
under the Output Status option.   

To enable the Sidebar, click the Sidebar 
button in the upper right of the program 

or hit Option+Command+I 

Here, you can choose which output you 
wish to use.  This can be a system output, sent through a supported SDI device or 
be sent over NDI or Syphon.  This feature is limited to sending to only one output 
and will need to have the Output Status toggled ON for the monitor to appear.   
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Network Backup Triggering 

PVP has the ability to send Cues and other triggers to one or more Backup (“Slave”) 
computers. This feature is designed so that you can have a backup computer 
running PVP that is automatically following the primary computer. You can set up 
as many Backup computers connected to one Primary computer as you would like. 

Note that, while similar to the Master/Slave functionality of previous versions of PVP, 
the core functionally of this feature has changed and thus has new abilities 

as well as new limitations in how it can be used. 

Setup 

The connection process is controlled by the Primary computer, however you will 
first need to set up and retrieve information from your Backup computer(s). First, 
on each Backup machine, head to the Network tab of PVP’s preferences and click 
the checkbox next to Enable to turn on this feature. Make a note of the Port 
number (which will be automatically generated). 

For added security click the checkbox next to Use HTTPS Connection  
and/or Require Authentication; if enabling the latter then you will need to make a 

note of the Authentication Token for that computer. 

In addition to this, you will need the IP Address of the computer; click on the Apple 
icon   in the upper left corner of your screen, select System Preferences, then 
click on the Network tab to see the computer’s IP address. 

Once you have all of the necessary information for each Backup computer, head to 
the Primary computer and open PVP’s Preferences to the Network tab. Click the 
checkbox next to Enable to enable the feature. Add a Slave by clicking the + in the 
lower left. To delete a machine, right click and select Delete or, if you have a 
touchpad, swipe to the left while the mouse is over that machine. 

For a given machine, click the checkbox to enable or disable that machine. You can 
add a custom Name to the machine to help remember which machine you are 
controlling. Type out the IP Address, Port, and Authentication Token (if required) 
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of the backup machine. Click the Uses HTTPS 
checkbox if you have that option selected on the 
Backup machine. 

How to Use 

Once set up, the Primary computer will send 
commands to all Backups that are enabled. 
Supported commands would be any changes made 
to PVP from the primary window; primarily this 
would include clicking on Cues and other Actions, 
but it can also include other events such as changing 
the Opacity on a specific Layer, or changing an Effect on the Master Layer. 

For more information on what does and does not get sent over the 
Network Backup Triggering feature, see this article. 

We recommend using the Use Relative Media Paths feature 
to assist with moving your Shows between computers; 

see Use Relative Media Paths for more information. 

Page   of  76 92

https://support.renewedvision.com/hc/en-us/articles/360011695734-What-does-and-doesn-t-get-sent-to-the-backup-machine-when-using-Network-Backup-Triggering-


Shows 

A Show is an encapsulated file on your computer that contains all of the 
information for an event, such as your Cues, media settings, Screens, Outputs, 
Targets, Masks, etc. 

Note that a Show does not contain the media itself (including Image Targets and 
Image Masks). If you share the Show between computers then you will need to re-

link your media on the new computer. 

If you have multiple events that have different Screens, Outputs, Targets, and/or 
Masks, then you can create a new Show to easily switch between these features. If 
your events all share the same Screens, Outputs, Targets, and Masks but simply 
reference new media, then it might be easier to create a Playlist for each of your 
events. 

To create a new Show, select New > Show from the File menu or press Command-
Shift-N. To duplicate your Show choose Duplicate Show from the File menu or press 
Command-Shift-S. 

Note that only one Show can be open at any given time. 

Use Relative Media Paths 

By default, when you add media into PVP, it references the media on the computer 
via an Absolute Path; that is, the link that PVP uses to access the media on the 
computer is the full path from the root of the hard drive to the file itself. This is 
beneficial in many cases (it allows you to be able to move your Show file without 
having to worry about your media), however it makes it difficult to share Shows and 
their media across multiple computers (as the Show would be referencing the 
media on the original computer which might not be the same path on the new 
computer). 

Page   of  77 92



If you will be sharing your Shows across multiple computers then you can tell your 
Show to instead use Relative Paths for the media. You turn this feature on by 
going to File > Use Relative Media Paths. (You can revert to Absolute Paths by 
going to File > Use Absolute Media Paths.) 

When using Relative Paths, PVP references the media relative to the Show file on 
the computer. The recommended use for this would be to create a folder on your 
computer that houses both your Show file as well as all of your media; these files 
can be in sub-folders if needed. Once you have created your Show, added the 
media into the Show, then saved the Show in the folder, you can move that folder 
anywhere on the computer or even to another computer, and because the media is 
linked using a Relative Path, the Show will continue to be able to find it. 

To see an example of the Relative Path feature in action, 
click Open Sample Show in the Welcome Window. 

Media Management 

PVP always links to the media based on where the media was when the media was 
added into PVP. This means that if you rename/move/delete media after you add it 
into PVP, then PVP will not be able to find the media and it will thus show the media 
as missing. 

When PVP can’t find a piece of media, PVP will show a warning triangle   to 
indicate that the media is missing. To fix this, right-click on the Cue, select Fix 
Invalid Action, and click on the name of the media that needs to be fixed; a 
dialogue box will appear where you can select a replacement file to be used for that 
Action.  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Test Patterns 

PVP allows you to show customizable Test Patterns on your screen to help align 
and calibrate your devices. 

  

To open the Test Pattern window, in the Menubar select Layers and click on Test 
Patterns. This will open a window that allows you to select which type of Test 
pattern you want to use as well as customize the selected Test Pattern. 

You can choose from the following Test Patterns: 
• Blend Grid 
• Color Bars 

• Focus 
• Gray Scale 

• Black Color 
• White Color 

• Custom Color  

To show the Test Pattern on all of your Layers, click the Show button at the bottom 
of the Test Pattern window. To edit a given Test Pattern, adjust the parameters at 
the top of the Test Pattern window. 

Not all Test Patterns have properties that can be adjusted. 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Timecode 

PVP can listen to a Timecode signal and fire Cues at a specific Timecode frame so 
that you can set up your Show to fire all necessary media at precisely the correct 
time. 

There are two steps to have PVP fire Cues at a given Timecode; one step is to have 
PVP listen to the Timecode, and the other is to enable the Timecode feature for a 
Playlist and to tell your Cues when you want them to fire. 

Note that you can perform these steps in any order, 
but they must both happen before the Timecode feature will work. 

Listening to Timecode 

Timecode works by PVP listening to an audio signal that is then decoded into hours, 
minutes, seconds, and frames. The first step would be to get the audio feed into the 
computer; this could be, for example, plugging the audio signal into the computer 
via the microphone port, using a USB audio card, or via a software solution. In any 
case, the computer must see it as an audio feed before 
PVP can listen to it. 

Once the audio feed has been brought into the 
computer, inside of PVP click on the Timecode button 
  on the top right of the window (or, alternately, access 
these same options via the Audio tab in Preferences). 
Inside the Timecode window you can select the audio 
Device that is supporting your Timecode signal. Click and hold the speaker button 
  to listen to the current feed. 

Next, select the correct Channel and Format for your system. You can also select 
your Default Behavior: Trigger will have the media trigger at the correct time, 
while Follow will have PVP listen to the timecode and if the Timecode changes (say 
the Timecode jumps backward five seconds) then PVP will update the media that is 
playing (the media will also jump back five seconds, in this example). 
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Click on the Listening checkbox to have PVP enable the Timecode feature; while 
this checkbox is checked PVP will listen to the Timecode signal and show you the 
current Timecode in the top right of the screen. Uncheck this box to have PVP stop 
listening to the signal. 

Note that the Listening checkbox must be checked (the Timecode icon   will be red) 
for the Timecode feature to fire Cues at their appointed time. 

Applying Timecode to Cues 

The other step to getting PVP firing your Cues at a given Timecode frame is to tell 
PVP which Cue you want to fire, and when you want it 
fired. 

First, add your Cues into a Playlist. Then right-click on 
that Playlist, hover over Timing, and click on Timecode; 
the Timecode icon   will appear next to the Playlist. To 
turn off this feature, right-click on the Playlist, hover 
over Timing, then click on None. 

To select a specific Timecode frame that a Cue will fire 
you must first be in the Action View (click on the Action 
View button   in the upper right of the Cue/Action 
View area). When the Timecode feature is enabled for a 
given Playlist, the Timecode icon   will appear below 
each Cue on the left side. Click on the time to change 
when the Cue will fire (HH:MM:SS;FF). Now enable the 
Timecode feature on this Playlist by clicking the 
Timecode icon   in the top right of the Action/Cue View area or by right-clicking on 
the Playlist and choosing Enabled under Timecode. 

Note that the Timecode feature must be enabled for that Playlist (the Timecode 
icon   will be red) for the Timecode feature to fire Cues at their appointed time. 
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Transitions 

PVP has a robust Transition feature that allows for media to be transitioned to and 
from the screen in many creative ways. For a list of the Transitions that PVP offers 
reference the Appendix. 

Transition Hierarchy 

There are many ways to assign Transitions; here is the hierarchy of how PVP will 
decide which Transition to use for a given piece of media: 

• Master Transition (set in the Master Layer) is the “default” transition for all 
media 

• Layer Transitions (set inside of individual Layers) will override the Master 
Transition 

• Media Transitions (set inside of the Inspector for individual pieces of media) 
will override the Master Transition as well as any Layer Transitions that might be 
active 

To set a Layer or Media Transition back to using the Master Transition, click the Use 
Master Transition button   at the top of the respective Transition window. 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Preferences 
Open PVP’s Preference window by clicking on PVP in the menu bar at the top left of 
your screen and selecting Preferences or by pressing Command-Comma. 

General 
 

Appearance 

macOS Mojave allows for the use of Light/Dark 
mode for software programs.  Choosing Dark 
will allow the program to run in Dark Mode 
with many darker black/grey colors in the 
program interface.  Choosing Light will allow 
the program to run in Light Mode with many 
white and lighter grey colors in the program 
interface.  The Use System Appearance 
checkbox enables/disables the option to use 
whichever mode is selected in the Mac System 
Preferences.  The program runs by default in 
Dark Mode.   

Playlist 

Enabling Show Scaling Icons will show an icon in the lower left of the media’s 
thumbnail to indicate what the scaling option is for that media. 

Triggering 

By default the Triggering system is set to Single-Step; using this option, when you 
click on an Action or a Cue PVP will load all of the media into memory and then fire 
all of the media files at the same time. This will fire all of the media as fast as it can, 
however because it loads all of the media first, in some situations (such as with 
high-quality video and/or with more complex setups) there may be a noticeable 
delay between the time you click on the media and the time it actually fires. 
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In these cases you may desire to change this setting to Two-Step in which one click 
will cue all of the media into memory and a second click will fire the media. Using 
this option takes an extra click, but because it loads the media first it means that 
the second click will fire the media instantly (without a delay for loading the media). 

Rendering 

Check Show Output On Launch to automatically turn the Output on whenever 
PVP launches. (Turn this feature off if you will be routinely opening PVP without 
your output devices connected.) Enable Show On-Screen Video Performance will 
enable on-screen diagnostics for your outputs. 

Import 

The Import Tab customizes the defaults for when a 
piece of media is imported. For example, under 
Scaling select which Scaling Behavior will be used 
any time a piece of media is imported into PVP. 

In the Image section you can select the default 
Duration that the Action will have (you can set it to a 
constant Time, a Random Time, or None). You can 
also select the default Next Behavior to control 
what will happen after the Duration finishes. 

You can also select which Playback Behavior and 
Next Behavior will be set any time a Video or Audio 
is imported. 
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Network 

Use the Network Tab to enable and customize the REST API, which allows you to 
control PVP over the network. 

Click API Reference to open a web page 
which will tell you more about the REST API as 
well as have full documentation for this 
feature; this documentation will be updated 
as the API is updated, and therefore is the 
recommended place to learn about the API. 

Click the checkbox next to Enable to allow 
PVP to receive commands via the REST API as 
well as enable the Network Backup Triggering 
feature of PVP 3. The Port number will be 
automatically filled, however it can be 
manually adjusted if needed. 

Check Use HTTPS Connection to force the REST API 
and Network Backup Triggering to use a secure connection. Check Require 
Authentication to force PVP to only allow devices to control it with an 
Authentication Token. Click Generate New Token to create a new Token. 

See Network Backup Triggering for more information on how to add and edit Slave 
Machines. 
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DMX 
 
The DMX Tab in Preferences is where you 
set which DMX channels will control PVP. 

Set the Base Address and the rest of the 
Addresses will automatically be filled in for 
that section. Click on the section on the 
left to see the full list of options on the 
right. Uncheck the check box to disable 
that section. 

Note that one or more options may have a submenu that you can drill into. 

The Workspace option controls the overall performance of PVP. For example, if 
you want to select a Playlist, or a Cue within the currently selected Playlist, you can 
do that using the Address listed in the Workspace option. 

There are also controls for specific Layers. Click the Add Layer Profile button to 
add additional Layers to the DMX control. You can set the Layer Index which 
controls which Layer that section will control. 

Click the Configure Device button to open the Devices Tab of the Preferences 
(covered below). 

Devices 

The Devices Tab of PVP allows you to configure the devices that are connected to 
PVP. To add a new DMX device, click the + button in the lower left and select DMX. 

Note that PVP 3 supports ArtNet over a network 
only; USB-DMX interfaces are not supported. 
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You can give each device a unique Name, and you can tell it if it should Auto 
Reconnect if the connection is lost. Next to 
Hardware you can select Art-Net, and next to 
Behavior select Device. 
 

As of the writing of this User Guide, 
Art-Net and Device are the only options. 

At the bottom of the window you can set up the 
Address, the Port number, and other options. 
Once you are done setting up your device you 
can click on the Back button on the top left. 

Once you have created a Device you will see it 
listed in the Devices Tab of preferences. Click 
the Connect button to connect to that Device. 
To Delete a Device, right click on it and select 
Delete, or click the Delete button from within 
the Settings window. 

Video Input 

This tab allows you to set Video Inputs into 
the program and then add them more easily 
into the Video Input Playlist.  Upon opening 
the window, you can select the number of 
Video Inputs you wish to have in the 
program by either manually entering the 
number or using the arrow buttons.   

You then can go to the dropdown menu by 
each input and select the Input device you 
wish to link it to.  This can be an internal 
camera on the Mac, SDI Input, NDI Input or 
Syphon Input.   
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To change which input device is assigned to an input, simply go to the dropdown 
for that Input and select either a new Input device or choose Remove Input Device 
for that Input to not be linked to a Video Source.   

You can also enter a Description here, this description is used for the Label on the 
Cue and for the + menu in the Video Input Playlist.   

Audio 

PVP 3 features many new Audio options that allow you to customize your audio 
inputs and outputs in many ways. The new Audio Tab is where many of these 
features are controlled. 

Timecode 

PVP has the ability to listen to a Timecode feed and fire media at a given frame. The 
settings in PVP’s Preferences mirror the settings set via the Timecode button   in 
the main window. See the Timecode section for more information. 

Inspector Output 

PVP allows you to Monitor audio from the Inspector 
on a different audio feed than your main output. This 
allows you to preview media in the Inspector during 
the show without the audience hearing it. 

To select which audio feed you want to hear audio 
from the Inspector, click on the drop-down menu 
next to Device and choose an audio output. To turn 
off this feature, click the checkbox next to Monitor 
On Main Output. 
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Main Output 

Use the arrow buttons or manually type in a number to set the Channel Count 
(how many channels of audio will be generated) of PVP. Similarly adjust the Audio 
Delay if you want all of the audio to be delayed out of PVP’s main output (this is 
useful if your video system has a delay in it and you need to delay your audio to 
match). 

Adjust the Master Level to control the volume of all audio being sent out of PVP. 

Click the drop-down next to Device to set which output will be used for the main 
output. Click Channel Routing to customize where specific channels of audio will 
be routed. (See the Audio Routing section above for more information.) 

Updates 
 
Enable Automatically Check for Updates and PVP will look for any new updates 
to the program when it launches and prompt for 
installation if an update is available.   

The Renewed Vision Development team will receive 
information from your usage of the program by 
enabling both Report Errors and Crash Reports 
and Share PVP Analytics.  
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Appendix 
Blend Modes 
• Normal 
• Alpha Matte 
• Luma Matte 
• White Matte 
• Dissolve 
• Darken 
• Multiply 
• Color Burn 

• Linear Burn 
• Darker Color 
• Lighten 
• Screen 
• Color Dodge 
• Linear Dodge 
• Lighter Color 
• Overlay 

• Soft Light 
• Hard Light 
• Vivid Light 
• Linear Light 
• Pin Light 
• Hard Mix 
• Difference 
• Exclusion 

• Subtract 
• Divide 
• Hue 
• Saturation 
• Color 
• Luminosity 

Effects 
• Adjust Color 
• Blur 
• Color Filter 
• Color Invert 
• Color Key 
• Color Posterize 
• Color Swap 
• CRT Monitor 
• Dots 

• Edge Blur 
• Edge Outline 
• Emboss 
• Gray Invert 
• Halftone 
• Heat Signature 
• Hexagon 
• Image Distortion 
• Kaleidoscope 1 

• Kaleidoscope 2 
• Lens Distortion 
• Old Film 
• Picasso 
• Pixelize 
• Plasma 
• Radial Blur 
• RGB Adjust 
• Ripple Center 

• Ripple Side 
• Sepia 
• Shake 
• Stars 
• Strobe 
• Tile 
• Toon 
• Two Color 
• Vignette  

Transitions 
Blurs 
• Dispersion Blur 
• Noisy Zoom 
• Zoom In 

Color 
• Color Burn 
• Color Push 
• Color Warp 
• Film Burn 

Dissolves 
• Dissolve 
• Fade 
• Fade Black 
• Fade Bright 
• Fade Dark 
• Fade Gray 
• Fade White 
• Warp Fade 
• Wave Dissolve 

Movements 
• Flip 
• Fly In 
• Iris 
• Mosaic 
• Move In 
• Push 
• Ripple 
• Swap 

None 
• Cut 

Objects 
• Cross Hatch 
• Cube 
• Door 
• Kaleidoscope Wipe 
• Random Pixels 
• Random Squares 
• Random Squares 

Flicker 

Wipes 
• Amoeba 
• Reveal 
• Square Wipe 
• Wipe  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Keyboard Shortcuts 

PVP Menu 
 Preferences Command-Comma 
 Hide PVP Commmand-H 
 Hide Others Command-Option-H 
 Quit PVP Command-Q 

File Menu 
 New Show Command-Shift-N 
 Open Show Command-O 
 Save Command-S 
 Duplicate Show Command-Shift-S 
 Save Show As Command-Option-Shift-S 

Edit Menu 
 Undo Command-Z 
 Redo Command-Shift-Z 
 Cut Command-X 
 Copy Command-C 
 Paste Command-V 
 Duplicate Command-Shift-D 
 Delete Delete 
 Select All Command-A 
 Deselect Command-D 
  

View Menu 
 Workspace Editor Command-E 
 Calendar Option-C 
 Sidebar Command-Option-I 

Layers Menu 
 New Layer Command-Option-N 
 Target Next Layer Option-Right Arrow 
 Target Previous Layer Option-Left Arrow 
 Select Master Option-0 
 Target Layer [1-9] Option-[1-9] 
 Clear All Layers Option-Shift-L 
 Clear Layer Option-L 
 Play/Pause Layer Option-P 
 Skip Backward Option-[ 
 Skip Forward Option-] 
 Go To Beginning Option-Shift-[ 
 Go To End Option-Shift-]  

Editor Menu 
Only available when the Workspace Editor is open. 

 Zoom In Option-Equals 
 Zoom Out Option-Minus 
 Zoom to Fit Command-0 
 Show/Hide Rulers Command-R 
 Show/Hide Grid Command-Option-Apostrophe 

Playlist Menu 
Only available when the Workspace Editor is closed. 

 New Playlist Command-N 
 Zoom In Playlist Command-Equals 
 Zoom Out Playlist Command-Minus 
 Zoom In Secondary Command-Shift-Equals 
 Zoom Out Secondary Command-Shift-Minus 

Calendar Menu 
Only available when the Calendar window is open. 

 Enable Calendar Command-Option-S 

Window Menu 
 Toggle Output Command-1 
 Minimize Command-M 
 Enter Full Screen Command-Control-F 

Help Menu 
 Find my Mouse Command-Option-M 

Inspector 
 Play/Pause Space 
 Mark In I 
 Mark Out O 
 Step Back Left 
 Step Forward Right 
 Skip Back Option-Left 
 Skip Forward Option-Right 
 Go To Beginning Command-Left 
 Go To End Command-Right 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Additional Resources 

Tutorial Videos 

In addition to this User Guide we have a set of Tutorial Videos that you may find 
useful in your PVP 3 journey: https://renewedvision.com/provideoplayer/tutorials/ 

User Forums 

If you have any questions or if you just want to join the community of PVP 3 users, 
feel free to post in our User Forums: forums.renewedvision.com 

Technical Support 

We hope that you have a trouble-free experience with our software, however if you 
are in need of technical support then don’t hesitate to reach out to us. 

We offer a wide variety of support options, including live chat, e-mail and scheduled 
phone support. Please visit our Support page for more information: 
support.renewedvision.com 

Social Media 

Twitter: @ProVideoPlayer, @RenewedVision, and @RVSupport 
Facebook: fb.com/ProVideoPlayer and fb.com/RenewedVisionApps 
Instagram: @ProVideoPlayer
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